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Page 3: Software License Agreement
ELECTRONIC FILE INCLUDED ON THE USER DOCUMENTATION CD-ROM INCLUDED HEREWITH;
HOWEVER, ALL SOFTWARE AND DOCUMENTATION DEVELOPED OR CRE- ATED BY OR FOR
TOSHIBA TEC CORPORATION (“TTEC”) ARE PROPRIETARY PROD- UCTS OF TTEC AND ARE
PROTECTED BY COPYRIGHT LAWS, INTERNATIONAL TREATY PROVISIONS, AND OTHER
APPLICABLE LAWS.
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Page 4: Limitation Of Liability
U.S. Government is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the
Rights in Technical Data and Computer Software Clause set forth in 252.227-7013, or 52.227-19
(c) (2) of the DOD FAR, as appropriate. Contractor/Manufacturer is TOSHIBA TEC Corporation,
6-78, Minami-cho, Mishima-shi, Shizuoka-ken, 411-8520, Japan.

Page 5: Trademarks And Copyright
Copyright © 2005 TOSHIBA TEC CORPORATION All rights reserved Under the copyright laws,
this manual cannot be reproduced in any form without prior written permission of TTEC. No
patent liability is assumed, however, with respect to the use of the infor- mation contained
herein.

Page 6: Preface
The term “e-Filing” in this manual is an abbreviation of “electronic filing”. Lineup of Our Manuals
Thank you for purchasing the TOSHIBA multifunctional digital systems e-STUDIO452 Series or e-
STUDIO282 Series. We have provided you with these manuals for the operation of this
equipment. Select and read the manual best suited to your needs.

Page 7 Operator’s Manual Basic Functions This Operator’s Manual Basic Functions describes
how to use the basic functions of this equipment mainly focusing on the copying function. Also
this manual contains safety precautions for users to be observed. Be sure to read it first
carefully. User Functions Guide This User Functions Guide describes the functions and settings
under the [USER FUNCTIONS] button on the control panel of this equipment.

Page 8 Network Administration Guide This Network Administration Guide explains the
guidelines for setting up network servers to provide various network services, and troubleshoot-
ing for network administrators. Printing Guide This Printing Guide explains how to install the
client software for printing from Microsoft Windows, Apple Mac OS, and UNIX computers, and
print to the equipment.

Page 9 Viewer The e-BRIDGE Viewer provides the functions to view and find the docu- ments
in e-Filing boxes on the TOSHIBA e-STUDIO MULTIFUNC- TIONAL DIGITAL SYSTEMS from a client
computer via TCP/IP network, and also it can view and find the files in your computer.

Page 10: Precautions In This Manual
Precautions in this manual To ensure correct and safe use of this equipment, this operator’s
manual describes safety pre- cautions according to the three levels shown below. You should
fully understand the meaning and importance of these items before reading this manual.

Page 11: Table Of Contents
TABLE OF CONTENTS SOFTWARE LICENSE AGREEMENT ............3 TRADEMARKS AND
COPYRIGHT...............5 Preface......................6 Chapter 1 Overview Features and Functions
................14 Functional Highlights ................14 Software Components ................14 Chapter 2
Installing Client Software Installing Network Fax Software ...............18 Overview....................18
Installing the N/W-Fax Driver and Address Book Viewer ......18 Uninstalling the N/W-Fax Driver
and Address Book Viewer ....27 When Installed Using the Installer ............27 When Installed
Using Add Printer Wizard ..........32...

Page 12 Chapter 5 Troubleshooting N/W-Fax Driver Errors ................116 N/W-Fax Driver
Installation Error Messages .........116 N/W-Fax Driver General Errors .............117 Address Book
Viewer Related Errors ............118 Chapter 6 Appendix Cover Sheet Samples................120
Standard Cover Page ................120 Business Cover Page ................121 Professional Cover
Page...............122 INDEX ............................123 TABLE OF CONTENTS...

Page 13: Chapter 1 Overview
Overview This section describes about the overview of the network fax features. Features and
Functions ..................14 Functional Highlights.........................14 Software
Components........................14...

Page 14: Features And Functions
1 Overview Features and Functions This equipment provides the network fax feature, which
simplifies and facilitates your office fac- simile needs that enables you to send fax or Internet
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fax digital documents directly from your desktop. This equipment also includes an Address Book
database, where you can store frequently used fax numbers or Internet Fax destinations and
other important recipient information, such as com- pany name, telephone number and postal
address.

Page 15 Address Book Viewer With the Address Book Viewer you can easily add or modify fax
recipient names, fax numbers, and Internet Fax address (e-mail address) to the Address Book.
This utility allows you to man- age recipients of the fax, select and display fax recipients from
the Address Book, as well as recipient fax numbers and other contact information.

Page 17 Installing Client Software This section describes the instructions on how to install the
client software for the network fax features. Installing Network Fax Software................18
Overview ............................18 Installing the N/W-Fax Driver and Address Book Viewer
..............18 Uninstalling the N/W-Fax Driver and Address Book Viewer .......27 When Installed
Using the Installer.....................27 When Installed Using Add Printer Wizard ..................32
Repairing Client Software ..................34...

Page 18: Chapter 2 Installing Client Software
2 Installing Client Software Installing Network Fax Software This chapter includes procedures for
installing software required to enable the fax printing and online address books for this
equipment. It is recommended that you read these instructions in their entirety before
beginning the installation process. Overview Before you can begin utilizing the network fax
feature for this equipment, you must install the software using the Client Utilities CD-ROM
provided.

Page 19 This section describes about installing the N/W-Fax driver and Address Book Viewer
in an SMB environment. The N/W-Fax driver can be set up using the same connection as a
printer driver such as USB printing, LPR printing, IPP printing, and Novell printing. To set up the
N/W-Fax driver using these connections, please refer to the Printing Guide.

Page 20 2 Installing Client Software Select “I accept the terms of the license agreement” and
click [Next]. The Setup Type screen is displayed. Select “Custom” and click [Next]. The Select
Components screen is displayed. Installing Network Fax Software...

Page 21 Check the software that you want to install and click [Next]. TOSHIBA e-STUDIO N/W-
Fax — check this to install the N/W-Fax driver. TOSHIBA e-STUDIO AddressBookViewer — check
this to install the Address Book Viewer. The Choose Destination Location screen is displayed.

Page 22 2 Installing Client Software When the equipment is automatically found in the
network, the “Device on Network” option is selected and the found devices are displayed in the
list. Select the equipment that you want to connect and click [Next]. The Select Program Folder
screen is displayed.

Page 23 3. The Browse for Folder dialog box appears. Locate this equipment in your network,
select the “print” queue, and click [OK]. - Do not select “pcl6”, or “ps3” queue. These queues
only accept the print job in each emulation. If you install several printer drivers and specify one
of these queues, the print job may not be printed properly due to mismatch of the emula- tions
between the print job and queue.

Page 24 2 Installing Client Software Click [Finish]. If you selected to install TopAccessDocMon
during the installation, the system may ask whether you want to view the Readme file and
launch TopAccessDocMon. The Installer may ask you to restart your computer. If it does, select
“Yes, I want to restart my computer now.”...

Page 25: Installing From Topaccess
Installing from TopAccess If the system administrator has uploaded the software to this
equipment, you can use TopAc- cess to install the software on your workstation. When using
Windows Server 2003 that the Service Pack is installed, the installation from TopAccess cannot
be performed.

Page 26 2 Installing Client Software Click the “Install Client1” link to download the installer
file. Download the installer file on your desktop by following the prompts. Double-click the
“InstallClient1.exe” file that you downloaded. The installer starts and the InstallShield Wizard
dialog box appears. Follow the installation procedure using the Client Utilities CD-ROM
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described in following section.

Page 27: Uninstalling The N/W-Fax Driver And Address Book Viewer
Uninstalling the N/W-Fax Driver and Address Book Viewer The following instructions describe
how to uninstall the N/W-Fax driver and Address Book Viewer. The uninstallation procedure is
different depending upon how you installed the client software. P.27 “When Installed Using the
Installer” P.32 “When Installed Using Add Printer Wizard”...

Page 28 2 Installing Client Software Select “TOSHIBA e-STUDIO452 Series Client” or
“TOSHIBA e- STUDIO282 Series Client” and click [Change/Remove]. The InstallShield Wizard
dialog box appears. Select “Remove” and click [Next]. The Confirm Uninstall dialog box
appears. Click [OK]. Uninstalling the N/W-Fax Driver and Address Book Viewer...

Page 29 Click [Yes] to delete the setting files. Deleting files starts. If you want to re-install the
client software later, click [No] to remain the setting files. You can restore the data and settings
when you re-install the client software. Select “Yes, I want to restart my computer now.” and
click [Finish] to restart your computer.

Page 30 2 Installing Client Software Open “Control Panel” and click the “Add/Remove
Programs” icon. The Add/Remove Programs dialog box appears. Select “TOSHIBA e-STUDIO452
Series Client” or “TOSHIBA e- STUDIO282 Series Client” and click [Change/Remove]. The
InstallShield Wizard dialog box appears. Uninstalling the N/W-Fax Driver and Address Book
Viewer...

Page 31 Select “Modify” and click [Next]. Uncheck the components that you want to uninstall
and click [Next]. Click [Next]. Uninstalling the N/W-Fax Driver and Address Book Viewer...

Page 32: When Installed Using Add Printer Wizard
2 Installing Client Software Click [Yes] to delete the setting files. Deleting files starts. If you want
to re-install the client software later, click [No] to remain the setting files. You can restore the
data and settings when you re-install the client software. Click [Finish].

Page 33 Click the [File] menu and select [Server Properties]. The Print Server Properties
dialog box appears. Display the Drivers tab. Select the N/W-Fax driver and click [Remove]. The
confirmation dialog box appears. Click [OK]. The N/W-Fax driver is completely deleted.
Uninstalling the N/W-Fax Driver and Address Book Viewer...

Page 34: Repairing Client Software
2 Installing Client Software Repairing Client Software When the client software will not work
correctly, you can repair the client software. Repairing Client Utilities Software The following
describes an installation on Windows XP. The procedure is the same when other versions of
Windows are used.

Page 35 Select “Yes, I want to restart my computer now.” and click [Finish] to restart your
computer. Repairing Client Software...

Page 37: Faxing From Client Computers
Faxing from Client Computers This section describes the instructions on how to send a fax using
the N/W-Fax driver. Faxing from Applications..................38 How to Fax using the N/W-Fax
Driver....................38 Setting up the N/W-Fax Options .......................52 Sending with Extended
Fax Functionality ..................57 Managing Faxes ......................61 Managing Fax Jobs using
TopAccessDocMon .................61 Managing Fax Jobs using TopAccess....................62...

Page 38: Faxing From Applications
3 Faxing from Client Computers Faxing from Applications You can use the N/W-Fax driver option
to electronically fax and Internet Fax from your computer to one or more recipients. In addition,
you can select fax properties, fax schedule options, include fax cover sheets and edit sender
information.

Page 39 Select “TOSHIBA e-STUDIO Series Fax” and Click [Properties]. The properties dialog
box appears. The procedures for displaying the properties dialog for the printer driver may be
different depending on the application you are using. See your application’s manual about dis-
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playing the printer properties dialog box.

Page 40 3 Faxing from Client Computers When you want to send a document with a fax cover
sheet, display the Cover Sheet tab, select the cover sheet type in the “Cover Sheet” drop down
box and specify the other options. If you enable the “Sender Information” option, continue to
the next step and specify the message to appear as the sender information.

Page 41: Specifying Recipients
When you enable the “Sender Information” option in the Cover Sheet tab, display the Sender
Information tab and enter the sender information message to appear the message on the fax
cover sheet. In the text field in the Sender Information tab, up to 500 characters can be
entered. For instructions on how to set the Sender Information, see the following section.

Page 42 3 Faxing from Client Computers P.51 “Removing recipients” Specifying recipients
from Address Book Click [Select From Address Book] in the Send tab. The Address Book Viewer
is launched. Faxing from Applications...

Page 43 Browse the address book category within the Address Book where desired recipients
are programed. Private Address Book — This contains the contacts registered in the associated
client address book on your client computer. Public Address Book — This contains the contacts
registered in the address book in this equipment.

Page 44 3 Faxing from Client Computers Select the contact you want to add as a recipient
and click the [Fax] icon ( ) in the tool bar to add the fax number as a recipient, and click the
[Mail] icon ( ) to add the e-mail address as a recipient.

Page 45 After you selected all recipients, right-click on a recipient name in the right pane and
select [Selection] in the menu displayed. The Destinations dialog box appears. You can also
display the Destinations dialog box by clicking the [Selection] icon ( ) in the tool bar.

Page 46 3 Faxing from Client Computers The Address Book Viewer is closed and selected
recipients are added to the “To” list. Searching recipients from address book Click [Select From
Address Book] in the Send tab. The Address Book Viewer is launched. Faxing from
Applications...

Page 47 Click the [Edit] menu and select [Find]. The Find Contact dialog box appears. Select
a address book to search contacts in the “Data Source” drop down box. The default address
book in the “Data Source” can be set by selecting [View] - [Default Configuration] - [Data
Source] from the menu bar.

Page 48 3 Faxing from Client Computers Display the Person tab and enter search text in the
following fields that you require. Name — Enter the search characters or string to search by the
first name. Fax Number — Enter the search characters or string to search by the contact fax
number.

Page 49 Check the “Email Address” check box if you want to add the Email address of the
selected contacts as the destinations, and check the “Fax Number” check box if you want to
add the fax number of the selected contacts as the destinations. The default destination type in
the “Type Selection”...

Page 50 3 Faxing from Client Computers The Address Book Viewer is closed and selected
recipients are added to the “To” list. Entering a recipient manually Click [New]. The Direct Dial
dialog box appears. To add an Internet Fax address as a recipient, select “Internet Fax
Address”...

Page 51: How To Setup
To add a fax number as a recipient, select “Fax Number” and enter the fax number in the right
field. In addition, if you specify a Sub address, enter the Sub address in the “SUB” field, and
security password for the Sub address in the “PWD” field if required. You can send to a fax
number only when the optional Fax unit is installed.

https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=40#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=41#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=42#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=43#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=44#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=45#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=46#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=47#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=48#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=49#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=50#manual
https://capturecode.com/manual/837424/Toshiba-E-Studio352.html?page=51#manual


Page 52: Setting Up The N/W-Fax Options
How to display: Click the [File] menu and select [Print] on an application. Select “TOSHIBA e-
STUDIO Series Fax” and Click [Properties]. Setting up the N/W-Fax Options N/W-Fax options are
the attributes you set to define the way a fax job is transmitted. For exam- ple, you can specify
the recipients, resolution, and paper size.

Page 53 To specify the recipients, you can select from the Address Book or enter the
recipient manually. P.41 “Specifying Recipients” 1) To This displays the specified recipients list.
2) [Select From Address Book] Click to launch the Address Book Viewer. You can select
recipients from the Address Book. P.42 “Specifying recipients from Address Book”...

Page 54 3 Faxing from Client Computers 6) Dept. Code Enter 5-digit department code if
required. When the department code is enabled on this equipment, you must enter the
department code to send a fax. If you do not enter the department code when the department
code is enabled on the equipment and the Department Code Enforcement is set to OFF in
TopAccess, the job will be stored in the Invalid job list without transmitting the job.

Page 55: Setting Up The Cover Sheet Properties
Setting up the Cover Sheet Properties In the Cover Sheet tab of the N/W-Fax properties dialog
box, you can specify the fax cover sheet to be sent. If you enable the cover sheet, the cover
sheet is attached in the first page of the doc- ument and sent to the recipients.

Page 56: Setting Up The Sender Information Properties
3 Faxing from Client Computers Setting up the Sender Information Properties In the Sender
Information tab of the N/W-Fax properties dialog box, you can specify the sender information
that appears on the cover sheet. This must be set only when the “Sender Informa- tion”...

Page 57: Sending With Extended Fax Functionality
Sending with Extended Fax Functionality The N/W-Fax driver allows users to perform the
following features. P.57 “Saving a Fax as File” P.57 “Delayed Transmission” P.58 “Sending with
a Cover Sheet” Saving a Fax as File You can save a document in the “TXFAX” folder in the
“FILE_SHARE” folder in this equipment as well as sending the document to fax numbers and
Internet Fax addresses.

Page 58: Sending With A Cover Sheet
3 Faxing from Client Computers Click [Edit]. The Scheduled Time dialog box appears. Select the
date and time and click [OK]. You can click the Date arrow to display a calendar then allows you
to select an date. Enter the time to commence the fax transmission. You can use the up and
down arrows to assist with setting the time with the proper format.

Page 59 Enter the subject to appear on the cover sheet in the “Subject” field. You can enter
up to 40 characters for the subject. Enter the message to appear on the cover sheet in the
“Message” field. You can enter up to 500 characters for the message. If you want the sender
information to appear on the cover sheet, check the “Sender Information”...

Page 60 3 Faxing from Client Computers If you want the recipients information to appear on
the cover sheet, check the “Recipients Information” box and check the items required for the
recipient information. Name — Check this to have the name of the recipient appear on the
cover sheet. Company —...

Page 61: Managing Faxes
Managing Faxes You can display manage the fax jobs using TopAccessDocMon and TopAccess.
P.61 “Managing Fax Jobs using TopAccessDocMon” P.62 “Managing Fax Jobs using TopAccess”
Managing Fax Jobs using TopAccessDocMon Users can use the TopAccessDocMon application’s
Fax tab to display the fax jobs that are cur- rently on this equipment.

Page 62: Managing Fax Jobs Using Topaccess
3 Faxing from Client Computers Click the Fax tab. The fax jobs list is displayed. If you want to
delete a fax job, select a fax job in the list, click the [Document] menu and select [Cancel]. The
selected job is deleted. Managing Fax Jobs using TopAccess Users can use TopAccess to display
the fax jobs that are currently on this equipment.
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Page 63 Managing Address Book This section describes the instructions on how to use the
Address Book Viewer. Running Address Book Viewer ................64 Running the Address Book
Viewer ....................64 About Address Book Viewer Interface ....................66 Using
Commands..........................67 Managing Address Book..................71 About the Address
Books........................71 Managing Contacts and Groups......................88 Converting the Address
Book Data....................108...

Page 64: Running Address Book Viewer
From the Program Group, you can access the Address Book Viewer to create and edit your pri-
vate address book. Accessing the Address Book Viewer from the Programs group Click the
[Start] menu, select [All Programs], [TOSHIBA e-STUDIO Client], and select [TOSHIBA e-STUDIO
AddressBookViewer].

Page 65 This method is only suggested if you are in the process of sending a fax and you
need to add a fax recipient to the send list that is not currently a member of the Address Book.
Otherwise, use the program group to access the Address Book Viewer. Accessing the Address
Book Viewer from the Print properties In the Print dialog box in the application, select the N/W-
Fax driver for the printer and click [Properties].

Page 66: About Address Book Viewer Interface
4 Managing Address Book Then the Destinations dialog box appears. [Remove] — Click this to
remove the selected contacts from the destinations list. [OK] — Click this to add these contacts
as the destinations. [Cancel] — Click this to cancel the selection. [Help] —...

Page 67: Using Commands
3) Browse Pane You can expand or collapse to view/hide Groups and Contact address book
entries. The browse pane contains a tree structure for the following address books: - Private
Address Book — This contains the contacts registered in the associated client address book on
your client computer.

Page 68 4 Managing Address Book - Import -vCard File — Select this to import the address
book data that had been exported as vCard files from e-STUDIO3510c Series, e-STUDIO451c
Series, e- STUDIO850 Series, e-STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO280 Series,
GL-1010 address book using the Address Book Viewer. The data will be imported in the “Import
Address Book”.

Page 69 5) Help The following commands can be selected in the Help menu. - Contents and
Index — Select this to display the Online Help. - About TOSHIBA e-STUDIO Address Book —
Select this to display the version informa- tion. Toolbar You can use following tool icon to
perform various functions quickly.

Page 70 4 Managing Address Book (Mail) — Click this to add the e-mail addresses of selected
contacts as destinations to be sent using the N/W-Fax driver. This icon is available only when
accessing the Address Book Viewer from the N/W-Fax driver properties dialog box and selecting
contacts. (Confirm Selection) —...

Page 71: Managing Address Book
N/W-Fax driver. The Address Book Viewer also displays a public address book that is the address
book in the compatible TOSHIBA equipment, such as e-STUDIO3510c Series, e-STUDIO451c
Series, e-STUDIO850 Series, e-STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO280 Series,
and GL-1010 controller for the e-STUDIO35/45. Using the Address Book Viewer, you can display
the contacts or groups in the address book and they can be copied to your private address
book.

Page 72: Managing The Public Address Book
4 Managing Address Book Managing the Public Address Book In order to access the public
address book in e-STUDIO3510c Series, e-STUDIO451c Series, e-STUDIO850 Series, e-
STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO280 Series, and GL-1010 controller for the e-
STUDIO35/45, you must configure the connection to the device. You can configure the
connection by searching the device in the network, or entering the IP address of the device
manually.

Page 73 Click [Start Discovery] to begin the process. It locates all the compatible devices in
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your network. You can quit the process by clicking [Stop Discovery]. If the process continues for
a long time, it is because the too many network clients are in the network.

Page 74: Configuring Discovery Settings
4 Managing Address Book Configuring Discovery Settings You can configure the discovery
settings. 1) Devices Click the arrow button to display the pull down list and check the model
name that you want to search. 2) Network - Enable IPX/SPX Search This is disabled because the
Address Book Viewer does not support the IPX/SPX connec- tion.

Page 75 Configuring the connection manually Click the [Tools] menu and select [Device
Setting]. The TopAccessDocMon Local Discovery dialog box appears. Click [Manual Selection].
The Manual Selection dialog box appears. Managing Address Book...

Page 76: Downloading The Public Address Book
4 Managing Address Book Enter each item to specify the printer address. IPv4 Address — Enter
the IPv4 address of the printer. IPv6 Address — Enter the IPv6 address of the printer. IPX
Address — This is disabled because the Address Book Viewer does not support the IPX/SPX
connection.

Page 77: Configuring The Mapi Address Book
The Address Book Viewer downloads the address book data that is backed up in the equipment
using TopAccess through FTP. Backing up the address book data can be operated by an
administrator. If the address book data is old, please ask your administrator to backup the
address book data.

Page 78: Managing The Microsoft Outlook Address Book
4 Managing Address Book Managing the Microsoft Outlook Address Book The Address Book
Viewer automatically accesses the Microsoft Outlook Express Address Book to obtain the
address book data. You use the MS Outlook address book to copy the contacts and groups to
the private address book. P.92 “Copying Contacts from an Address Book”...

Page 79 In the General tab, enter the items as described below. Directory Server Name —
Enter the server name or IP address of a LDAP server. This Server requires me to log on —
Check this if the LDAP server requires the user name and password to log on.

Page 80 4 Managing Address Book Click [Add]. The entered directory service is added to the
Directory Service list. Repeat the procedure from Step 2 to Step 3 until all required direc- tory
services are added. Click [Close]. — Adding Contacts from LDAP Servers After you register the
LDAP directory services, you can search contacts in the LDAP servers and add preferred
contacts to the LDAP Address Book.

Page 81 Display the Person tab and enter search text in the following fields that you require.
Name — Enter the search characters or string to search by the contact name. Fax Number —
Enter the search characters or string to search by the contact fax number.

Page 82 4 Managing Address Book Select contacts that you want to add to the LDAP Address
Book, and click [Add]. The selected contacts are added to the LDAP Address Book. Searching
contacts by detailed search conditions Click the [Edit] menu and select [Find]. The Find Contact
dialog box appears.

Page 83 Display the Detail Setting tab and select a field to search in the “Field Select” drop
down box. Select how it searches contacts in the “Condition of search string” drop down box.
Contains — Select this to search contacts that contain the search string. Is —...

Page 84: Importing And Exporting The Address Book
4 Managing Address Book Repeat the procedure from Step 3 to Step 6 to add all required con-
ditions. You can remove the search conditions you have added. To do this, select the condition
and click [Delete]. Click [Search]. It begins searching contacts in the LDAP server. When it
completes searching, found contacts appear in the list at the bottom of the dialog box.

Page 85 The CSV file to import the Address Book Viewer must be created as the comma
separated file in the following format: Group Name,Contact Key,Prefix,First Name,Last
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Name,Suffix,Display Name,Company Name,Department Name,First Fax Number,Second Fax
Number,Email Address,Furigana,One Touch ID,Notes,Attenuation,Error Correction Mode,Fax
Mode,Line Monitor,Line Selection,Option Type,Oversea Calls,Print Transmission Report,Short
Protocol,Transmission
Type,UseDeviceSettings,UseSubAddSID,Compression,PageWidth,Resolution,Password,SenderIde
ntification,SEP,SubAddress ,1,,User01,User,,User01
User,12345COMPANY,Dept01,00000000001,,user01@ifax.com,,1,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,
, ,2,,User02,User,,User02
User,12345COMPANY,Dept02,00000000002,,user02@ifax.com,,2,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,
,...

Page 86 4 Managing Address Book Click the [File] menu and select [Import] and [CSV File] or
[vCard File]. The Importing dialog box appears. The [vCard File] command will appear only when
Microsoft Office XP is installed on your computer. Even if you import a vCard file that contains
multiple contacts, only a single contact can be imported.

Page 87 The address book data is imported into “Import Address Book”. If you have already
been import an address book before, contacts information will be overwritten the existing
import address book. If one or more records have been skipped during the import process, it
may be due to one of following reasons: Record already exists.

Page 88: Managing Contacts And Groups
4 Managing Address Book Exporting the address book as a CSV file or vCard File Click the [File]
menu and select [Export] and [CSV File] or [vCard File]. The Exporting dialog box appears. The
[vCard File] command will appear only when Microsoft Office XP is installed on your computer.

Page 89: Managing Contacts
Managing Contacts You can add contacts to the “Location/People” folder and each created
groups in the Private Address Book. There are several ways to add the contact to the container.
P.89 “Adding Contacts Manually” P.92 “Copying Contacts from an Address Book” Also you can
modify or delete contacts in the private address book.

Page 90 4 Managing Address Book Click the [File] menu and select [New Contact]. The New
Contact dialog box appears. Managing Address Book...

Page 91 In the Personal tab, enter items as described below. One Touch ID — Select the one
touch ID number for the contact (if desired). Prefix — Select the prefix for the contact. First
Name — Enter the first name of the contact. You can enter up to 32 characters. Last Name —...

Page 92: Copying Contacts From An Address Book
4 Managing Address Book In the Sending Options tab, enter items as described below as
required. Use Sub Address and sender information — Check this to enable subaddress
transmission for this contact. When this is checked, documents will be always sent using the
specified sub address and SID.

Page 93: Displaying Or Modifying Contacts Properties
Click the [Edit] menu and select [Copy]. The selected contacts are copied in the clipboard.
Browse the Private Address Book and select a folder that you want to add the copied contacts in
the left pane. If you want to copy individual contacts in the private address book, select the
“Loca- tion/People”...

Page 94 4 Managing Address Book Displaying or modifying the contact properties Browse to
the folder that contains the contacts you want to display or modify, and select the contact in the
right pane. Click the [File] menu and select [Properties]. The Properties dialog box appears. You
can also display the Properties dialog box by double-clicking the contact in the right pane.

Page 95 Personal Tab In the Personal tab, following items are displayed: When displaying the
properties of a contact in the private address book, you can modify all items. One Touch ID —
Display the one touch ID number for the contact. Prefix —...

Page 96 4 Managing Address Book Sending Options tab In the Sending Options tab, following
items are displayed: When displaying the properties of a contact in the private address book,
you can modify the fol- lowing settings: Use Sub Address and sender information Sub Address
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Sender Identification Items other than the above cannot be set.

Page 97: Removing Contacts
Internet Fax Mode — Display whether the simple mode or full mode is used for the Internet Fax
transmission. Setting Value — Display whether to use auto detect receiver capability or manual
settings for the Internet Fax transmission. When “Default” is selected, it enable auto detect
receiver capability for the Internet Fax transmission.

Page 98: Creating Groups
4 Managing Address Book After you create a group, you can add or delete contacts in the group.
For the instruction to add contacts in a group, please refer to the following section. P.89
“Managing Contacts” — Creating Groups You can create groups in the “Group” folder in the
private address book. Creating groups Select the “Group”...

Page 99 Continue to add contacts to the group. P.89 “Managing Contacts” — Modifying
Groups Name You can change the group name of the groups in the private address book. You
can also display the properties of a group in the public address book. Modifying the group name
Select the group that you want to display or modify the group prop- erties in the “Group”...

Page 100: Removing Groups
4 Managing Address Book When you display the properties of the group in the private address
book, modify the group name in the “Group Name” field and click [OK]. The group name of
selected group is modified. You cannot modify the group of the public address book. —...

Page 101: Searching Contacts
Click the [File] menu and select [Delete]. The Confirm Deletion dialog box appears. Click [Yes].
The selected group is deleted. Searching Contacts In order to quickly locate contacts you can
search the Address Book database. You simply type in a string or letters to be used to search
the database. The Address Book Viewer will search for any entry that contains the specified
string.

Page 102 4 Managing Address Book Searching contacts by name, fax number, and e-mail
address Click the [Edit] menu and select [Find]. The Find Contact dialog box appears. Select a
address book to search contacts in the “Data Source” drop down box. The default address book
in the “Data Source”...

Page 103 Display the Person tab and enter search text in the following fields that you
require. Display Name — Enter the search characters or string to search by the display name.
Fax Number — Enter the search characters or string to search by the contact fax number.

Page 104 4 Managing Address Book Searching contacts by detailed search conditions Click
the [Edit] menu and select [Find]. The Find Contact dialog box appears. Select a address book
to search contacts in the “Data Source” drop down box. The default address book in the “Data
Source” can be set by selecting [View] - [Default Configuration] - [Data Source] from the menu
bar.

Page 105 Select how it searches contacts in the “Condition of search string” drop down box.
Contains — Select this to search contacts that contain the search string. Is — Select this to
search contacts that completely match the search string. Start with — Select this to search
contacts that start with the search string. End with —...

Page 106 4 Managing Address Book Repeat the procedure from Step 3 to Step 6 to add all
required con- ditions. You can remove the search conditions you have added. To do this, select
the condition and click [Delete]. Click [Search]. It begins searching contacts in the selected
address book. When it completes searching, found contacts appear in the list at the bottom of
the dialog box.

Page 107 Select the searched contacts and click [Address]. The Type Selection dialog box
appears. Check the “Email Address” check box if you want to add the Email address of the
selected contacts as the destinations, and check the “Fax Number” check box if you want to
add the fax number of the selected contacts as the destinations.
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Page 108: Converting The Address Book Data
4 Managing Address Book Click [OK]. The selected contacts are added as recipients for N/W-Fax.
Converting the Address Book Data Using the Address Book Converter, users can convert the
GL-1010 or GL-1020 address book file to the file that can be restored or imported to the e-
STUDIO3510c Series, e-STUDIO451c Series, e-STUDIO850 Series, e-STUDIO4511 Series, e-
STUDIO450 Series, or e-STUDIO280 Series with TopAccess.

Page 109 Converting from an address book converter file Click the [Tools] menu and select
[Convert for TopAccess]. The Converting AddressBook dialog box appears. Click [Browse] at the
next of the “Input file” field. Locate the folder that contains the address book converter file
(*.abc).

Page 110 4 Managing Address Book Select the model name that the selected file is originally
created from in the “Machine Type” drop down box. Click [Browse] at the next of the “Output
File” field. Locate the folder where you want to save a converted file. Select “TBF (Restore)
(*.tbf)”...

Page 111 Click [Convert]. It starts converting a file. Click [OK]. The file is converted and
saved in the selected folder. After you convert the file, you can restore or import the address
book into the equipment using the restore or import function of the TopAccess. For instructions
on how to restore or import the address book, refer to the TopAccess Guide.

Page 112 4 Managing Address Book Click [Browse] at the next of the “Input file” field. Locate
the folder that contains the CSV file. Select “CSV (Comma Separated Values) (*.csv)” in the
“Files of type” drop down box, select the file, and click [Open]. Select the model name that the
selected file is originally created from in the “Machine Type”...

Page 113 Locate the folder where you want to save a converted file. Select “CSV (Comma
Separated Values) (*.csv)” in the “Save as type” drop down box, enter the file name in the “File
name” field, and click [Save]. When you selected a CSV file for the input file, do not specify “TBF
(Restore) (*.tbf)” in the “Save as type”...

Page 115: Troubleshooting
Troubleshooting This section describes about troubleshooting for printing features. N/W-Fax
Driver Errors ..................116 N/W-Fax Driver Installation Error Messages ................... 116 N/W-
Fax Driver General Errors....................... 117 Address Book Viewer Related
Errors....................118...

Page 116: N/W-Fax Driver Errors
5 Troubleshooting N/W-Fax Driver Errors N/W-Fax Driver Installation Error Messages Setup
Needs to Copy Windows NT Files Problem Description The wrong port type was selected from
the Printer Ports dialog. Corrective Action 1. Click Cancel until the Add Printer Wizard
terminates. 2.

Page 117: N/W-Fax Driver General Errors
This Port is Currently in Use Problem Description The driver was either open, printing a job, or is
in use by another printer or application, when you attempted to delete it. Corrective Action
Make sure all print jobs have completed before deleting a port. If there are still problems, exit
all applications and try again.

Page 118: Address Book Viewer Related Errors
5 Troubleshooting Connect the Network Fax driver with this equipment through the TopAccess.
If connection fails, reboot the computer and this equipment. Address Book Viewer Related
Errors Cannot Select from Address Book Problem Description The Address Book is not opened
even if the [Select From Address Book] is pressed. Corrective Action The Address Book Viewer
may not be installed.

Page 119 Appendix This section shows the cover sheet samples. Cover Sheet Samples
...................120 Standard Cover Page........................120 Business Cover
Page........................121 Professional Cover Page ........................122...
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Page 120: Cover Sheet Samples
6 Appendix Cover Sheet Samples Standard Cover Page Reference Number: 0000000000000000
00000000001 From: MFP-00C67861 Subject: N/W-Fax Document Message: This is a N/W-Fax
Document. Cover Sheet Samples...

Page 121: Business Cover Page
Business Cover Page Reference Number: 0000000000000000 00000000001 From:
MFP-00C67861 Subject: N/W-Fax Document Message: This is a N/W-Fax Document. Cover Sheet
Samples...

Page 122: Professional Cover Page
6 Appendix Professional Cover Page Reference Number: 0000000000000000 00000000001
From: MFP-00C67861 Subject: N/W-Fax Document Message: This is a N/W-Fax Document. Cover
Sheet Samples...

Page 123: Index
INDEX ........68 Export - vCard File ...........70 Export to vCard ..69 About TOSHIBA e-STUDIO
Address Book ..........79 Account Name ..........70 Add - Contact ............. 91 ..........70 Add - Group
......48 Fax Number ......15 Address Book Viewer ..........62...

Page 124 ....... 55 Sender Information ......56 Sender Information Properties ........... 14 N/W-
Fax Driver ........79 Server Port Number ........52 N/W-Fax Options ..........97 Setting Value
..........48 Name ..........96 Short Protocol .............50 ..........68 Small Icons ........67 New Contact
........19 SMB environment ...........67 New Group .........14 Software Components ...........91...

Page 125 DP-3540/4540 DP-2050/2340/2840 OME050113C0...

Page 126 MULTIFUNCTIONAL DIGITAL SYSTEMS Network Fax Guide 2-17-2,
HIGASHIGOTANDA, SHINAGAWA-KU, TOKYO, 141-8664, JAPAN R05092094003-TTEC Ver03
2007-03 ©2005 TOSHIBA TEC CORPORATION All rights reserved...

This manual is also suitable for:

E-studio452E-studio282E-studio202lE-studio232E-studio281cE-studio351c ... Show all
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